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1 What’s New in This Release
Oracle Business Intelligence Applications consists of components that were formerly available from 
Siebel Systems as Siebel Business Analytics Applications (both CRM and Enterprise) with a number 
of significant enhancements.

The Oracle Business Intelligence Applications Upgrade Guide contains information about upgrading 
to Oracle Business Intelligence Applications from different versions of Siebel Business Analytics 
Applications. 

Oracle recommends reading the Oracle Business Intelligence Applications Release Notes before 
installing, using, or upgrading Oracle Business Intelligence Applications. The Oracle Business 
Intelligence Applications Release Notes are available:

■ On the Oracle Business Intelligence Applications CD-ROM.

■ On the Oracle Technology Network at http://www.oracle.com/technology/documentation/
bi_apps.html (to register for a free account on the Oracle Technology Network, go to http://
www.oracle.com/technology/about/index.html).

What’s New in Oracle Business Intelligence Applications Upgrade 
Guide, Version 7.9
Every section of the Oracle Business Intelligence Applications Upgrade Guide was extensively revised 
to support Release 7.9 of the software.

Changes to Oracle Business Analytics Warehouse Schema
The Siebel Data Warehouse (also referred to as the Siebel Relationship Management Warehouse) was 
renamed to Oracle Business Analytics Warehouse.

The Oracle Business Analytics Warehouse schema contains the following changes:

■ System columns. New system columns were added to support incremental ETL processes, audit 
trail functionality, and multi-tenancy applications.

■ SCD dimensions. Dimension tables are now SCD capable. New effectivity date columns were 
added.

■ Obsolete tables. _SCD dimension tables were made obsolete.

■ Deleted obsolete Columns. Dropped columns from W_ORG_D that were made obsolete to 
resolve performance issues on Oracle databases.

■ Consolidated Customer Entity. Integrated the CONTACT-type customer into W_ORG_D to 
create a single CUSTOMER entity in the data model. 

■ Renamed columns for Teradata database support. Renamed columns (type, status, and so 
on) in the data model to enable creation of columns on Teradata databases.
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What’s New in This Release ■ 
Changes to Oracle BI Repository
The Siebel Analytics repository (SiebelAnalytics.rpd) was renamed to the Oracle Business 
Intelligence Applications repository (OracleBIApplicationsApps.rpd).

The Oracle BI repository contains the following changes:

■ Naming conventions. Logical tables have been renamed to start either with "Dim," to indicate 
dimension tables, or "Fact," to indicate fact tables.

■ Data security. The position security design was modified to use the new table W_POSITION_DH 
instead of W_PARTY_LOGIN. For more information about data security, see the Oracle Business 
Intelligence Applications Installation and Configuration Guide.

■ Presentation layer. Some old catalogs have been replaced with new catalogs. The catalogs that 
have been replaced are designated with a STOP icon in the presentation layer; these catalogs 
will be deleted in a future release. It is highly recommended that you migrate your reports to the 
corresponding new catalogs.

■ Time dimension. A common time dimension is used in all new catalogs to indicate a unified time 
dimension across all facts. Some secondary date dimensions are still exposed when necessary, 
but they are not conformed to all facts, and, thus, should be used cautiously.
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2 Overview of Oracle BI 
Applications Upgrade
This chapter provides an overview of the Oracle Business Intelligence Applications upgrade process. 
It includes the following topics:

■ Supported Upgrade Paths on page 7

■ Preupgrade Considerations on page 7

■ Best Practices for Preparing to Upgrade on page 8

■ Major Stages of Oracle BI Applications Upgrade on page 10

Supported Upgrade Paths
Oracle Business Intelligence Applications Upgrade Guide provides instructions for upgrading to 
Oracle Business Intelligence Applications version 7.9 from the previous versions of Siebel Analytics 
beginning with version 7.5.x.

The major stages of the upgrade process are the same for each of these upgrade paths, except for 
the upgrade from version 7.5.x. The upgrade from version 7.5.x requires that you upgrade your data 
warehouse schema and migrate your data first from version 7.5.x to 7.7, and then upgrade your 
schema and migrate your data from version 7.7. to 7.9.

You can upgrade directly to Oracle Business Intelligence Applications versions 7.9 from any of the 
previous versions listed below.

■ Siebel Business Analytics 7.7

■ Siebel Business Analytics 7.7.1.x

■ Siebel Business Analytics 7.8.x

■ Siebel Business Analytics for Life Sciences 7.8.0, 7.8.1, and 7.8.2

NOTE: To upgrade from Life Sciences version 7.8.3 or 7.8.4, follow the upgrade instructions for 
Siebel Business Analytics 7.8.x.

Preupgrade Considerations
You should consider the following points before you begin your upgrade:

■ Review the System Requirements and Supported Platforms for Oracle Business Intelligence 
Applications on Siebel SupportWeb to make sure your database platform versions are supported.
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Overview of Oracle BI Applications Upgrade ■ Best Practices for Preparing to Upgrade
■ The upgrade process is not only a technical process. You will also need to analyze the impact of 
the schema changes on your current custom implementation. The extent of your customizations 
will have an impact on the length of time required for the upgrade.

In addition, at different stages of the upgrade you will also need to analyze your organization’s 
business requirements. For example, at the stage in which you are upgrading the Oracle Business 
Intelligence repository, you will need to know which repository objects are not in use so that they 
can be trimmed from the repository. To determine this information, you will need to know what 
reports are in use.

■ You should determine what customizations were made to your existing DAC repository before you 
begin the upgrade process. Moving the customizations in your existing DAC repository into the 
new DAC repository is a manual process.

■ For each stage of the upgrade process, you need to allocate a reasonable amount of time to 
validate the results of that stage and address any problems. In addition, final user acceptance 
testing must confirm that the entire upgrade process was successful.

■ When you upgrade the Siebel Analytics Web Catalog to the Oracle BI Presentation Catalog, it is 
highly recommended that you use side-by-side environments and have users review and 
compare reports and dashboard content between the previous version and the upgraded version.

For the other stages of the upgrade, you can upgrade your environments in place. However, for 
comparison and benchmarking purposes, it is recommended that you upgrade using side-by-side 
environments.

■ When you move from a development environment to test or production environments, you must 
perform the following stages of the upgrade process for each environment:

■ Upgrade the Platform

■ Upgrade the Applications

■ Migrate Data

You can migrate the DAC, Informatica, and Oracle BI repositories into the production 
environment after you merge and test them.

For a description of the major stages of the upgrade process, see “Major Stages of Oracle BI 
Applications Upgrade” on page 10.

Best Practices for Preparing to Upgrade 
This section provides best practice steps you need to perform before you begin the upgrade process.

■ Review this guide, Oracle Business Intelligence Applications Upgrade Guide, in its entirety.
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Overview of Oracle BI Applications Upgrade ■ Best Practices for Preparing to Upgrade
■ Rename and copy into a different location your current repositories, Web catalog, and DAC 
installation folder from your existing environment. The file names and locations listed below 
represent the standard names and locations of files that shipped with previous versions of Siebel 
Business Analytics Applications.

When you backup the DAC repository, you export the DAC metadata, in XML format (using the 
DAC’s Export tool), into a different database, which can be used later as a reference. For 
instructions, see the Oracle Business Intelligence Data Warehouse Administration Console Guide.

■ Gather information that describes the current implementation, including the following:

■ Version of the Siebel transactional database to which you upgraded.

■ Version of the Siebel Business Analytics platform from which you are upgrading.

To determine the Analytics platform version from which you are upgrading, launch the Siebel 
Analytics Administration Tool, and click Help > Administration Tool in the toolbar. A message 
box provides the platform version.

■ Version of Siebel Business Analytics Applications from which you are upgrading.

To determine the version of Siebel Business Analytics Applications from which you are 
upgrading, launch the Data Warehouse Administration Console (DAC), and click Help > 
Metadata Version. A message box provides the metadata version, which will be either 7.7, 
7.7.1, or 7.8.

❏ If your metadata version is 7.7, you are running Siebel Analytics 7.7.

❏ If your metadata version is 7.7 and your transactional database version is 6.3.x, you are 
running the Siebel Analytics Bridge - 6.3.

❏ If your metadata version is 7.7 and your transactional database version is 7.5.x, you are 
running the Siebel Analytics Bridge - 7.5.

❏ If your metadata version is 7.7.1, you are running Siebel Analytics Bridge 7.7.1.x.

❏ If your metadata version is 7.8, you are running Siebel Business Analytics Applications 
version 7.8.x.

NOTE: If the DAC is not a component of your Analytics installation, you are running Analytics 
7.5.x.

Type Name Location

DAC metadata 
repository

*.xml SiebelAnalytics\DAC\export

Analytics 
repository

SiebelAnalytics.rpd SiebelAnalytics\Repository

Informatica 
repository

Siebel_DW_rep.rep SiebelAnalytics\dwrep\Informatica\Rep
ository

Web catalog <file_name>.webcat SiebelAnalyticsData\Web\catalog

DAC installation 
folder

DAC SiebelAnalytics\DAC
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Overview of Oracle BI Applications Upgrade ■ Major Stages of Oracle BI Applications 
Upgrade
Major Stages of Oracle BI Applications 
Upgrade
Figure 1 shows the upgrade flow for the major stages of the Oracle Business Intelligence Applications 
upgrade process. Table 1 provides the documentation you should refer to for each stage of the 
upgrade. For the detailed steps and tasks associated with each stage, see Table 2. 

Sequence of Upgrade Stages
You must complete stages one through five sequentially, in the following order: 1) upgrade the Siebel 
Business Analytics platform to the Oracle BI Infrastructure; 2) upgrade the Siebel Business Analytics 
Applications to the Oracle Business Intelligence Applications; 3) upgrade the metadata in the DAC 
and Informatica repositories; 4) upgrade the data warehouse schema; 5)upgrade the Siebel 
transactional database schema.

Figure 1. Oracle Business Intelligence Applications Upgrade Flow
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Overview of Oracle BI Applications Upgrade ■ Major Stages of Oracle BI Applications
Upgrade
You can perform stages six through eight simultaneously; that is, you can migrate data into the 
upgraded data warehouse (stage six), upgrade the Siebel Analytics repository (stage seven), and 
upgrade the Web catalog (stage eight) at the same time. However, you cannot test the results of 
your Web catalog upgrade, which you do in the procedure “Testing the Results of the Presentation 
Catalog Upgrade” on page 59, until you have finished migrating your data. 

CAUTION: It is highly recommended that you consider obtaining support from Professional Services 
to assist with the end-to-end upgrade process. 

Table 1. Major Stages of the Oracle Business Intelligence Applications Upgrade and Related 
Documentation

Stage Related Documentation

1 Upgrade the Siebel Business Analytics 
Platform to Oracle BI Infrastructure.

NOTE: The Oracle Business Intelligence 
infrastructure is code-independent from the 
Oracle Business Intelligence Applications. 

■ Oracle Business Intelligence Infrastructure 
Upgrade Guide

2 Upgrade the Siebel Business Analytics 
Applications to Oracle Business Intelligence 
Applications.

■ Oracle Business Intelligence Applications 
Upgrade Guide

3 Upgrade the DAC and Informatica 
repositories.

■ Oracle Business Intelligence Applications 
Upgrade Guide

■ Oracle Business Intelligence Data 
Warehouse Administration Console Guide

4 Upgrade the data warehouse schema. ■ Oracle Business Intelligence Applications 
Upgrade Guide

5 Upgrade the Siebel transactional database 
schema.

■ Oracle Business Intelligence Applications 
Upgrade Guide

6 Migrate data into the upgraded data 
warehouse.

■ Oracle Business Intelligence Applications 
Upgrade Guide

7 Upgrade the Siebel Analytics repository to 
the Oracle BI repository.

■ Oracle Business Intelligence Applications 
Upgrade Guide

■ Oracle Business Intelligence Server 
Administration Guide

8 Upgrade the Siebel Business Analytics Web 
Catalog to the Oracle BI Presentation 
Catalog.

■ Oracle Business Intelligence Applications 
Upgrade Guide

■ Oracle Business Intelligence Infrastructure 
Upgrade Guide

■ Oracle Business Intelligence Presentation 
Services Administration Guide
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Overview of Oracle BI Applications Upgrade ■ Major Stages of Oracle BI Applications 
Upgrade
NOTE: Upgrading Oracle’s Siebel Customer Relationship Management applications is out of the scope 
of this document. Upgrading your current version of Siebel CRM applications is optional.
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3 Upgrading Oracle BI 
Applications
This chapter provides the detailed tasks required to upgrade Oracle Business Intelligence 
Applications. The following topics are included:

■ Detailed Tasks for Upgrading to Oracle BI Applications on page 13

■ Upgrading Oracle BI Infrastructure on page 15

■ Upgrading Oracle BI Applications on page 15

■ Upgrading the DAC Repository on page 15

■ Upgrading to Informatica Version 7.1.4 on page 18

■ Upgrading the Informatica Repository on page 18

■ Upgrading the Data Warehouse Schema on page 19

■ Process of Upgrading the Siebel Transactional Database Schema on page 21

■ Migrating Data into the Upgraded Data Warehouse on page 22

■ Verifying ETL Customizations on page 52

■ Process of Upgrading the Siebel Analytics Repository on page 52

■ Process of Upgrading the Analytics Web Catalog on page 57

Detailed Tasks for Upgrading to Oracle 
BI Applications
Table 2 provides the detailed steps and corresponding tasks you need to perform to upgrade to Oracle 
Business Intelligence Applications. It also provides a link to the instructions for each task or a cross-
reference for an alternative guide.

You must perform stages one and two sequentially. You can perform stages three, four, and five 
simultaneously, but you must perform the tasks for these stages in the order listed in Table 2.

Table 2. Detailed Task List for Upgrading Oracle Business Intelligence Applications

Step
Instructions for Task Corresponding to 
Step

Stage 1: Upgrade the Platform

1 Upgrade the Siebel Business Analytics 
Platform to Oracle BI Infrastructure.

Oracle Business Intelligence Infrastructure 
Upgrade Guide.

Stage 2: Upgrade the Applications
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Upgrading Oracle BI Applications ■ Detailed Tasks for Upgrading to Oracle BI Applications
2 Upgrade the Siebel Business Analytics 
Applications to Oracle Business Intelligence 
Applications.

Oracle Business Intelligence Applications 
Installation and Configuration Guide.

Stage 3: Upgrade the DAC and Informatica Repositories

3 Upgrade the Data Warehouse Administration 
Console (DAC) repository.

Upgrading the DAC Repository on page 15.

4 Upgrade the Informatica platform. Upgrading to Informatica Version 7.1.4 on 
page 18

5 Upgrade the Informatica repository. Upgrading the Informatica Repository on page 18

Stage 4: Upgrade the Data Warehouse Schema

6 Upgrade the data warehouse schema. Upgrading the Data Warehouse Schema on 
page 19

Stage 5: Upgrade Siebel Transactional Database Schema

7 Upgrade the Siebel Transactional Database 
Schema

Process of Upgrading the Siebel Transactional 
Database Schema on page 21

8 Import new schema definitions into the 
Siebel transactional Database.

■ Importing New Schema Definitions into 
the Siebel Transactional Database on 
page 21

9 Verify the Siebel transactional database 
upgrade.

■ Verifying the Siebel Transactional 
Database Upgrade on page 22

Stage 6: Migrate Data

10 Migrate data into the upgraded data 
warehouse.

Process of Upgrading the Siebel Analytics 
Repository on page 52

11 Verify ETL customizations. Verifying ETL Customizations on page 52.

Stage 7: Upgrade the Siebel Analytics Repository

12 Upgrade the Siebel Analytics repository to 
the Oracle BI repository.

Process of Upgrading the Siebel Analytics 
Repository on page 52.

a Prepare for the Analytics repository 
upgrade.

■ Preparing for the Analytics Repository 
Upgrade on page 53

b Equalize the Analytics repositories. ■ Equalizing the Analytics Repositories on 
page 54.

c Compare the Analytics repositories ■ Comparing the Analytics Repositories on 
page 55.

d Merge the Analytics repositories. ■ Merging the Analytics Repositories on 
page 55.

Table 2. Detailed Task List for Upgrading Oracle Business Intelligence Applications

Step
Instructions for Task Corresponding to 
Step
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Upgrading Oracle BI Applications ■ Upgrading Oracle BI Infrastructure
Upgrading Oracle BI Infrastructure
For information on upgrading the Siebel Analytics platform to the Oracle Business Intelligence 
Infrastructure, see the Oracle Business Intelligence Infrastructure Upgrade Guide.

Upgrading Oracle BI Applications
For instructions on installing the Oracle BI Applications, see Oracle Business Intelligence Applications 
Installation and Configuration Guide.

Upgrading the DAC Repository
Before you begin this procedure, do the following:

■ Determine what customizations were made to your existing DAC repository. Moving the 
customizations in your existing DAC repository into the new DAC repository is a manual process.

■ Make sure you have renamed and backed up your existing DAC repository into a different 
database. When you backup the DAC repository, you export the DAC metadata, in XML format 
(using the DAC’s Export tool), into a different database, which can be used later as a reference. 
For instructions, see the Oracle Business Intelligence Data Warehouse Administration Console 
Guide.

■ Create and configure a new DAC repository according to the instructions in Oracle Business 
Intelligence Applications Installation and Configuration Guide.

e Regression test the Analytics repository 
merge.

■ Regression Testing the Analytics 
Repository Merge on page 57.

Stage 8: Upgrade the Web Catalog

13 Upgrade the Siebel Business Analytics Web 
Catalog to the Oracle BI Presentation 
Catalog.

Process of Upgrading the Analytics Web 
Catalog on page 57

a Trim the Web Catalog. ■ Trimming the Input Web Catalog on 
page 58

b Upgrade the Analytics Web Catalog to the 
Oracle BI Presentation Catalog.

■ Upgrading the Analytics Web Catalog to 
the Oracle BI Presentation Catalog on 
page 58

c Test the results of the Presentation 
Catalog upgrade.

■ Testing the Results of the Presentation 
Catalog Upgrade on page 59

Table 2. Detailed Task List for Upgrading Oracle Business Intelligence Applications

Step
Instructions for Task Corresponding to 
Step
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Upgrading Oracle BI Applications ■ Upgrading the DAC Repository
■ Make sure you have set up the DAC system properties, Informatica Server, Informatica 
Repository Server, and database connections according to the instructions in Oracle Business 
Intelligence Applications Installation and Configuration Guide.

■ Make a copy of your preconfigured source system container. (You cannot change the metadata 
in the preconfigured container. You must make a copy of it in order to be able to modify the 
objects it contains. For instructions, see Oracle Business Intelligence Data Warehouse 
Administration Console Guide.

In this step you will manually move your customizations from your previous DAC repository into the 
new DAC repository.

To manually move your customizations from the previous DAC repository into the 
new DAC repository

1 In the DAC, open the copy of the source system container into which you want to move your 
customizations.

2 Import the custom data warehouse tables:

a Navigate to Design > Tables. 

b Right-click and select Import from Database > Import Database Tables.

c In the Data Sources drop-down list, select DataWarehouse.

d Click Read Tables.

e Select the tables you want to import, and then click Import Tables.

3 Import the custom columns for the tables you imported in Step 2:

a In the Tables tab, query for the tables you imported in Step 2.

b Right-click and select Import from Database > Import Database Columns.

c In the Importing Columns... dialog box, select “All records in the list,” and click OK.

d In the Data Sources drop-down list, select DataWarehouse.

e Click Read Columns.

f Select the columns you want to import, and then click Import Columns.

g Navigate to Tables > Columns and add the Foreign Key to Table and Foreign Key to Column 
attributes for the newly imported columns.

4 Import the indices for the custom data warehouse tables.

a In the Tables tab, query for the tables you imported in Step 2.

b Right-click and select Import Indices.

c In the Importing Indices... dialog box, select “All records in the list,” and click OK.

d In the Data Sources drop-down list, select DataWarehouse.

e Click Read Indices.

f Select the indices you want to import, and then click Import Indices.
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Upgrading Oracle BI Applications ■ Upgrading the DAC Repository
5 Import the custom source tables:

a Navigate to Design > Tables. 

b Right-click and select Import from Database > Import Database Tables.

c In the Data Sources drop-down list, select the appropriate source.

d Click Read Tables.

e Select the tables you want to import, and then click Import Tables.

NOTE: You do not have to import columns for the custom source tables. Columns for source 
tables are not required.

6 Import columns for any standard data warehouse tables that were extended, and add the 
appropriate attributes in the DAC.

7 Create new custom logical and physical task folders.

a In the DAC, navigate to Tools > Seed Data > Task Folders.

b To create a custom logical folder, click New.

c In the Name field, enter a name for the custom logical folder, for example, Custom Logical.

d In the Type field, select Logical.

e To create a custom physical folder, click New.

f In the Name field, enter a name for the custom physical folder, for example, Custom Physical.

g In the Type field, select Physical.

8 Register the folders you created in Step 7 in the Source System Folders tab.

a Navigate to Design > Source System Folders.

b Click New.

c Enter the name of the Custom Logical folder in the Logical Folder field.

d Enter the name of the Custom Physical folder in the Physical Folder field, and save the record.

9 Modify the task attributes for workflows in the custom folder that are modified standard 
mappings, that is, standard (out-of-the-box) mappings from the previous release that you copied 
into the Informatica custom folder.

a Navigate to the Tasks tab and query for the Informatica workflow names that are in the 
Informatica custom folder under Command for Incremental Load or Command for Full Load.

NOTE: You need to review the workflows in the custom folder in Informatica Workflow 
Manager.

b For each task, change the Folder Name (in the Edit child tab) to the Custom Logical folder name.

c For each task, right-click and select Synchronize Tasks.

d In the Task Synchronization dialog box, select Selected Record Only, and click OK.

This step adds source and target tables to the task.
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Upgrading Oracle BI Applications ■ Upgrading to Informatica Version 7.1.4
e Click Yes in the Synchronizing Task(s)... dialog box to proceed.

An informational message will indicate the results of the process.

f Click OK.

10 Add tasks that were created as new tasks in the current implementation.

a In the DAC, navigate to Tasks > Edit.

b For each new task, copy the names of the Informatica workflows into the fields Command for 
Incremental Load and Command for Full Load.

c Assign the appropriate values for the remaining fields in the Edit child tab.

d In the Tasks tab, query for the tasks you entered in Step b.

e Right-click the list of query results, and in the Task Synchronization dialog box, select “All records 
in the list,” and click OK.

This step adds source tables and target tables to the task.

f Click Yes in the Synchronizing Task(s)... dialog box to proceed.

An informational message will indicate the results of the process.

g Click OK.

NOTE: If your customizations included new fact tables, you will need to create and assemble new 
subject areas as well as create and build new execution plans. If your customizations included 
extending dimension tables, you will need to reassemble your existing subject areas and rebuild your 
existing execution plans. You will also need to set the appropriate execution plan attributes, such as 
Prune Days. For instructions, see Oracle Business Intelligence Data Warehouse Administration 
Console Guide.

You will verify the DAC repository upgrade in the procedure “Verifying ETL Customizations” on 
page 52, which you perform after the data migration.

Upgrading to Informatica Version 7.1.4
For information on upgrading to Informatica version 7.1.4, see the Informatica documentation, which 
is provided in the Third_Party_Software\Informatica\Informatica 7.1.4 PowerCenter Doc folder of the 
Oracle Business Intelligence Applications CD-ROM.

NOTE: You do not need to uninstall the previous version of Informatica before running the 
installation program. However, you need to stop the Informatica service before you install the 
Informatica Server and stop the Repository Server service before you install the Repository Server.

Upgrading the Informatica Repository
Follow this procedure to upgrade the Informatica repository.
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Upgrading Oracle BI Applications ■ Upgrading the Data Warehouse Schema
To upgrade the Informatica repository

1 Make sure you have backed up and renamed your current Informatica repository.

For instructions, see the Informatica documentation, which is provided in the 
Third_Party_Software\Informatica\Informatica 7.1.4 PowerCenter Doc folder of the Oracle 
Business Intelligence Applications CD-ROM.

2 Copy the Oracle_BI_DW_Base.rep file from the folder OracleBI\dwrep\Informatica\Repository 
into the folder Informatica PowerCenter 7.1.4\RepositoryServer\bin\Backup.

3 Launch the Informatica Repository Console and restore Oracle_BI_DW_Base.rep (located in 
Informatica PowerCenter 7.1.4\RepositoryServer\bin\Backup).

4 Copy the custom folder from your previous Informatica repository to the newly created 
Informatica repository:

a Launch the Informatica Repository Manager, and connect to both your previous and newly 
created Informatica repositories.

b Copy the Custom folder in your previous repository into the newly created Informatica 
repository.

c Create an individual workflow for each of the mappings in the Custom folder.

d New system columns were added to the Oracle Business Analytics Warehouse for Oracle BI 
Applications version 7.9. Review your custom mappings to determine whether the new columns 
need to be added to the mapping.

e Register the mappings in the DAC.

You will verify your customized mappings in the procedure “Verifying ETL Customizations” on 
page 52, which you perform after the data migration.

Upgrading the Data Warehouse Schema
NOTE: This procedure applies to all upgrade paths except for upgrades from version 7.5.x. If you 
are upgrading from version 7.5.x, go directly to one of the following procedures: “To migrate data 
from version 7.5.x to 7.9 (Horizontal)” on page 22, or “To migrate data from version 7.5.x to 7.9 
(Vertical)” on page 34. These procedures provide instructions for upgrading the data warehouse 
schema. 

This procedure adds new tables, columns, and indexes to the existing data warehouse schema. It 
does not alter or disrupt your existing data. During this procedure, you will run four different scripts. 
Below is a description of what each script does.

Data Warehouse Schema Upgrade Scripts (for All Versions Except 
7.5.x)
■ UPGRADE.ctl. This script upgrades older schemas to the Siebel Industry Applications 7.8.4 

version. It adds new tables and columns and modifies existing columns. It also adds lookup 
tables. This script is necessary for all previous versions of Siebel Business Applications and Siebel 
Industry Applications.
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■ 790_UPGRADE_PRE_CTL_SCRIPT.sql. For all database types except for DB2, this script 
renames columns to support Teradata databases. It also adds default values in columns in case 
a column changes from nullable to not null, and truncates all fact and dimension staging tables.

For DB2 databases, this script does not rename columns. Instead, the new columns are updated 
with the old values in the 790_UPGRADE_PRE_DIMENSION_SCRIPT.sql.

■ DW.ctl. This script upgrades the schema to the version Oracle BI Applications 7.9.

■ 790_UPGRADE_PRE_DIMENSION_SCRIPT.sql. This script creates backup tables for the 
dimension and fact tables that are being updated during the 7.8.4 to 7.9 upgrade. The backup tables 
are called <table_name>_784. 

This script also sets the SRC_EFF_FROM_DT and EFFECTIVE_FROM_DT to 1/1/1899 in the tables 
where these columns were defaulted to SYSDATE in DW.ct.

For DB2 databases, this script contains update commands to load new column names from the 
old column names.

To upgrade the data warehouse schema

1 Run the UPGRADE.ctl script.

This script upgrades older schemas to the version of Siebel Industry Applications 7.8.4, from 
which in a later step you will upgrade to version 7.9.

a Navigate to the folder OracleBI\dwrep\Upgrade\CTLFiles.

b Use the DDLimp utility to run the UPGRADE.ctl script. Use the following command:

..\OracleBI\dwrep\bin\DDLIMP /U <USER> /P <PASSWORD> /C <ODBC connect string>
/G SSE_ROLE /R Y /F <..\OracleBI\dwrep\UPGRADE.CTL>
/L <..\oracleBI\dwrep\UPGRADE.log> 

For example: 

DDLIMP /U SADMIN /P SADMIN /C SIEBEL_OLTP /G SSE_ROLE
/R Y /F C:\OracleBI\dwrep\UPGRADE.CTL /L C:\OracleBI\dwrep\UPGRADE.log 

Notes: 

❏ /P <PASSWORD> - The password for Oracle’s CRM OLTP. 

❏ /C <ODBC connect string> - The name of the ODBC connect string. 

❏ For Oracle databases, use the Siebel Merant ODBC Drivers. 

❏ In addition, you can use the following commands: 

❏ /W Y - If the OLTP database is Oracle and Unicode.

❏ /Z Y - If the OLTP database is DB2 or SQL Server and Unicode. 

❏ /B <TABLE_SPACE_NAME> - If you want to create these tables in a separate table space. 
For DB2, This must be specified as 32K tablespace.

❏ /X <INDEX_TABLE_SPACE_NAME> - If you want to create the indexes in a separate 
tablespace. For DB2, This must be specified as 32K tablespace.
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❏ /Y - Storage File for DB2/390.

❏ /R - Regrant tables.

2 Run the 790_UPGRADE_PRE_CTL_SCRIPT.sql script.

a Open the SQL client for your database type, for example, SQLPLUS for Oracle, Query 
Analyzer for SQL Server, or a command window for DB2.

b Navigate to the folder OracleBI\dwrep\Upgrade\DbScripts\<database type>.

c Open the 790_UPGRADE_PRE_CTL_SCRIPT.sql file, and copy the contents into the SQL client.

d Execute the script.

3 Navigate to the folder OracleBI\dwrep\Upgrade\CTLFiles, and use the DDLimp utility to run the 
DW.ctl script.

Use the command provided in Step 1, but substitute the correct script name.

4 Run the 790_UPGRADE_PRE_DIMENSION_SCRIPT.sql script.

a Open the SQL client for your database type.

b Navigate to the folder OracleBI\dwrep\Upgrade\DbScripts\<database type>.

c Open the 790_UPGRADE_PRE_DIMENSION_SCRIPT.sql file, and copy the contents into the SQL 
client.

d Execute the script.

Process of Upgrading the Siebel 
Transactional Database Schema
This procedure upgrades transactional database objects that relate to Oracle Business Intelligence 
Applications. It does not upgrade transactional database objects for CRM applications.

This process includes the following tasks:

■ Importing New Schema Definitions into the Siebel Transactional Database on page 21

■ Verifying the Siebel Transactional Database Upgrade on page 22

Importing New Schema Definitions into the Siebel 
Transactional Database
Follow this procedure to import new schema definitions into the Siebel transactional database.

To import new schema definitions into the Siebel transactional database
■ Use the DDLimp utility to run the DDL_OLTP.ctl script that is located in the 

OracleBI\dwrep\Upgrade\CTLFiles folder.
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Verifying the Siebel Transactional Database Upgrade
Follow this procedure to verify the following tables were created in the Siebel transactional database.

To verify the transactional database upgrade
■ For all upgrade paths, verify the following tables were created in the Siebel transactional 

database:

■ S_ETL_R_IMG_1 through S_ETL_R_IMG_166

■ S_ETL_I_IMG_1 through S_ETL_I_IMG_166

■ S_ETL_D_IMG_1 through S_ETL_D_IMG_166

■ S_ETL_PARAM

■ S_ETL_PRD_ATTR

■ S_ETL_PRD_REL

Migrating Data into the Upgraded Data 
Warehouse
To migrate data into the upgraded data warehouse, follow the appropriate procedure listed in Table 3 
based on the version of Analytics from which you are upgrading.

To migrate data from version 7.5.x to 7.9 (Horizontal)
NOTE: Upgrading from version 7.5.x requires two stages. In the first stage, you upgrade the data 
warehouse schema and migrate the data from version 7.5.x to 7.7. In the second stage, you upgrade 
the data warehouse schema and migrate the data from version 7.7 to 7.9.

Table 3. Procedures for Migrating Data

From Version Procedure

Siebel Analytics 7.5.x (Horizontal) ■ To migrate data from version 7.5.x to 7.9 (Horizontal) on 
page 22

Siebel Business Analytics 7.7, 
7.7.1.x, or 7.8 (Horizontal)

■ To migrate data from versions 7.7, 7.7.1.x, or 7.8 to 7.9 
(Horizontal) on page 29

Siebel Industry Applications 7.5.x 
(Vertical)

■ To migrate data from version 7.5.x to 7.9 (Vertical) on 
page 34

Siebel Industry Applications 7.7, 
7.7.1.x, or 7.8 (Vertical)

■ To migrate data from versions 7.7, 7.7.1.x, or 7.8 to 7.9 
(Vertical) on page 41

Life Sciences 7.8.0, 7.8.1, or 7.8.2 
(Vertical)

■ To migrate data from Life Sciences 7.8.0, 7.8.1 or 7.8.2 to 
7.9 on page 47
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1 Upgrade the data warehouse schema from version 7.5.x to 7.7 by using the DDLimp utility to run 
the script ddlsme_HOR_77.ctl script.

a Navigate to the folder OracleBI\dwrep\Upgrade\CTLFiles.

b Use the DDLimp utility to run the ddlsme_HOR_77.ctl script. Use the following command:

..\OracleBI\dwrep\bin\DDLIMP /U <USER> /P <PASSWORD> /C <ODBC connect string>
/G SSE_ROLE /R Y /F <..\OracleBI\dwrep\ddlsme_HOR_77.ctl>
/L <..\oracleBI\dwrep\ddlsme_HOR_77.log> 

For example: 

DDLIMP /U SADMIN /P SADMIN /C SIEBEL_OLTP /G SSE_ROLE
/R Y /F C:\OracleBI\dwrep\ddlsme_HOR_77.ctl /L 
C:\OracleBI\dwrep\ddlsme_HOR_77.log 

Notes: 

❏ /P <PASSWORD> - The password for Oracle’s CRM OLTP. 

❏ /C <ODBC connect string> - The name of the ODBC connect string. 

❏ For Oracle databases, use the Siebel Merant ODBC Drivers. 

❏ In addition, you can use the following commands: 

❏ /W Y - If the OLTP database is Oracle and Unicode.

❏ /Z Y - If the OLTP database is DB2 or SQL Server and Unicode. 

❏ /B <TABLE_SPACE_NAME> - If you want to create these tables in a separate table space. 
For DB2, This must be specified as 32K tablespace.

❏ /X <INDEX_TABLE_SPACE_NAME> - If you want to create the indexes in a separate 
tablespace. For DB2, This must be specified as 32K tablespace.

❏ /Y - Storage File for DB2/390.

❏ /R - Regrant tables.

2 Copy the file Upgrade.rep file from the folder OracleBI\dwrep\Upgrade\Informatica\Repository 
into the folder Informatica PowerCenter 7.1.4\RepositoryServer\bin\Backup.

3 Launch the Informatica Repository Console and restore Upgrade.rep (located in Informatica 
PowerCenter 7.1.4\RepositoryServer\bin\Backup).

4 Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\ParameterFiles and copy the file 
753_TENERIFE_UPG_PARAMS.txt into the SrcFiles folder on the Informatica Server machine, for 
example, C:\Program Files\Informatica PowerCenter 7.1.4\Server\SrcFiles.

5 Rename 753_TENERIFE_UPG_PARAMS.txt to TENERIFE_UPG_PARAMS.txt.

6 In Informatica Workflow Manager, navigate to the folder UPGRADE_753_to_770_HOR, and 
execute the following workflows in the order indicated:

a Upgrade_R_Image

b Upgrade_Unspecifieds

c Upgrade_Agree
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d Upgrade_Asset

e Upgrade_Opty

f Upgrade_Order

g Upgrade_Quote

h Upgrade_Response

i Upgrade_ServiceRequest

j Upgrade_Others

k Upgrade_Visibility

l UpgradeSlowlyChangingDimensionStartDates

m DAC_Metadata_Upgrade_Workflow

7 Upgrade the data warehouse schema from version 7.7 to 7.9 by following the steps in the 
procedure “To upgrade the data warehouse schema” on page 20.

8 Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\SrcFiles and copy the *.csv files into 
the SrcFiles folder on the Informatica Server machine, for example, C:\Program 
Files\Informatica PowerCenter 7.1.4\Server\SrcFiles.

9 Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\ParameterFiles and copy the file 
770_TENERIFE_UPG_PARAMS.txt into the SrcFiles folder on the Informatica Server machine, for 
example, C:\Program Files\Informatica PowerCenter 7.1.4\Server\SrcFiles.

10 Rename 770_TENERIFE_UPG_PARAMS.txt to TENERIFE_UPG_PARAMS.txt.

11 In the file TENERIFE_UPG_PARAMS.txt:

a Search for the parameter $$SourceConnection.

b Set the value to one of the following options, based on your Siebel applications (OLTP) version:

❏ SEBL_63

❏ SEBL_753

❏ SEBL_771

❏ SEBL_78

❏ SEBL_80

❏ SEBL_VERT_753

❏ SEBL_VERT_771

❏ SEBL_VERT_78

❏ SEBL_VERT_80

For example, if your Siebel applications (OLTP) version is Siebel Industry Applications 7.5.x, 
the parameter should appear as:

$$SourceConnection=SEBL_VERT_753

12 In the file TENERIFE_UPG_PARAMS.txt:
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a Search for the parameter $$Source_Container.

b Set the value to one of the following options, based on your Siebel applications (OLTP) version:

❏ Siebel 6.3

❏ Siebel 7.5.3

❏ Siebel 7.5.3 Vertical

❏ Siebel 7.7.1

❏ Siebel 7.7.1 Vertical

❏ Siebel 7.8

❏ Siebel 7.8 Vertical

❏ Siebel 8.0

❏ Siebel 8.0 Vertical

For example, if your Siebel applications (OLTP) version is Siebel Industry Applications 7.5.x, 
the parameter should appear as:

$$Source_Container=Siebel 7.5.3 Vertical

13 In the file TENERIFE_UPG_PARAMS.txt, edit the ETL_PROC_WID parameter as follows:

MPLT_GET_ETL_PROC_WID.$$ETL_PROC_WID=<latest ETL_PROC_WID value from your database>

You can get this value from W_PARAM_G.ETL_PROC_WID.

14 In the Informatica Workflow Manager, open the Relational Connection Browser (Connections > 
Relational), and do the following:

a Edit the preconfigured ODBC connection PARAM_OLTP_SIEBEL to point to the Siebel 
transactional database.

b Edit the preconfigured ODBC connection DataWarehouse to point to the newly upgraded data 
warehouse database.

c Edit the preconfigured ODBC connection PARAM_DAC_OLD to point to the previous DAC 
repository database (the version from which you are upgrading).

d Edit the preconfigured ODBC connection PARAM_DAC_NEW to point to the new DAC repository 
database (the version to which you are upgrading).

15 In Informatica Workflow Manager, navigate to the folder UPGRADE_770_to_79, and execute the 
following workflows in the order indicated:

a MARKETING_LOAD

b Update_Dimensions

c Update_Dimension_Unspecified

d Update_Facts

e SIL_PositionDimensionHierarchy_Full

f Load_INT_ORG_DH
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g DIMENSION_LOAD

h DIMENSION_UNSPECIFIED_UPDATE

i FACT_UPDATE

16 Run the Reset_infa_seq_gen.bat script to initialize the Informatica sequence generator for 
incremental runs:

a Navigate to the directory \OracleBI\dwrep\Upgrade\DbScripts\<database type>.

b Open the Reset_infa_seq_gen.bat script, and review the parameters at the top of the file.
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c Replace the existing values for the parameters to reflect your environment (the parameters 
are database-specific).

For Oracle databases:

For Microsoft SQL Server databases:

Parameter Setting

TARGET_USERID_PWD <olap schema user-name>/<olap schema password>@<olap 
database TNS name> 

For example:

TARGET_USERID_PWD=siebel/siebel@siebel_olap

INFA_USERID_PWD <user-name of Informatica Repository database that 
contains the adapter mappings repository metadata>/
<password of the Informatica Repository database>@<TNS 
name of the database for the Informatica Repository>

For example:

INFA_USERID_PWD=INFAREP/INFAREP@infa.corp.siebel.com

INFA_REP Name of the Informatica Repository where the adapter 
mappings are available.

INFA_U User name of the administrator of the Informatica Repository.

INFA_P Password for the administrator of the Informatica Repository.

INFA_SRV Name of the Informatica Server.

Parameter Setting

OLAP_SERVER Name of the SQL Server for the OLAP database.

OLAP_DB Name of the database on which OLAP data is available.

OLAP_U User name for logging into the database on which OLAP data is 
available.

OLAP_P Password for logging into the database on which OLAP data is 
available.

INFA_SERVER Name of the SQL Server for the Informatica Repository 
database.

INFA_DB Name of the database on which Informatica Repository 
metadata is available.

INFA_U User name for logging into the database on which Informatica 
Repository metadata is available.

INFA_P Password for logging into the database on which Informatica 
Repository metadata is available.
Oracle Business Intelligence Applications Upgrade Guide Version 7.9 27



Upgrading Oracle BI Applications ■ Migrating Data into the Upgraded Data Warehouse
For IBM DB2 databases:

d Run the script.

NOTE: Because the Reset_infa_seq_gen.bat file contains user names and passwords, it is 
recommended that you delete the file after the upgrade process is complete.

17 To verify the data migrated successfully:

a Check whether any of the Informatica mapping log files stored in the directory \Informatica 
PowerCenter 7.1.4\Server\SessLogs indicates errors or failures.

b Check whether the SQL scripts (790_UPGRADE_PRE_CTL_SCRIPT.sql and 
790_UPGRADE_PRE_DIMENSION_SCRIPT.sql) that you ran in the SQL client of the database 
failed or errored out while executing.

c Check the log files for the CTL files (Upgrade.ctl and DW.ctl) that you ran using the DDLimp 
command to determine whether any of the runs failed.

If you did not detect any errors or failures in the steps above, then the data migration was 
successful.

INFA_REP Name of the Informatica Repository where adapter mappings 
are available.

INFA_REP_U User name of the administrator of the Informatica Repository.

INFA_REP_P Password of the administrator of the Informatica Repository.

Parameter Setting

TARGET_USERID_PWD <olap schema user-name>/<olap schema password>@<olap 
database name>

For example:

TARGET_USERID_PWD=siebel/db2@OLAP_DB2DB

INFA_USER User name for logging into the database on which Informatica 
metadata is available.

INFA_PWD Password for logging into the database on which Informatica 
Repository metadata is available.

INFADB_ALIAS Name of the database in which Informatica Repository 
metadata is available.

INFA_REP Name of the Informatica Repository where the adapter 
mappings are available.

INFA_U User name of the administrator of the Informatica Repository.

INFA_P Password of the administrator of the Informatica Repository.

INFA_SRV Name of the Informatica Server.

Parameter Setting
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18 (Optional) If the data migration was successful, drop the tables that were created during the 
upgrade process, such as, W_xxxx_x_784 tables, LKP_xxxx_x, and W_ASSET_D_TMP.

This step frees the space occupied by these backup tables.

To migrate data from versions 7.7, 7.7.1.x, or 7.8 to 7.9 (Horizontal)

1 Copy the file Upgrade.rep file from the folder OracleBI\dwrep\Upgrade\Informatica\Repository 
into the folder Informatica PowerCenter 7.1.4\RepositoryServer\bin\Backup.

2 Launch the Informatica Repository Console and restore Upgrade.rep (located in Informatica 
PowerCenter 7.1.4\RepositoryServer\bin\Backup).

3 Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\SrcFiles and copy the *.csv files into 
the SrcFiles folder on the Informatica Server machine, for example, C:\Program 
Files\Informatica PowerCenter 7.1.4\Server\SrcFiles.

4 Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\ParameterFiles and copy the file 
<previous version of Siebel Analytics>_TENERIFE_UPG_PARAMS.txt into the SrcFiles folder on 
the Informatica Server machine, for example, C:\Program Files\Informatica PowerCenter 
7.1.4\Server\SrcFiles.

5 Rename the file <previous version of Siebel Analytics>_TENERIFE_UPG_PARAMS.txt to 
TENERIFE_UPG_PARAMS.txt.

6 In the file TENERIFE_UPG_PARAMS.txt:

a Search for the parameter $$SourceConnection.

b Set the value to one of the following options, based on your Siebel applications (OLTP) version:

❏ SEBL_63

❏ SEBL_753

❏ SEBL_771

❏ SEBL_78

❏ SEBL_80

❏ SEBL_VERT_753

❏ SEBL_VERT_771

❏ SEBL_VERT_78

❏ SEBL_VERT_80

For example, if your Siebel applications (OLTP) version is Siebel Industry Applications 7.5.x, 
the parameter should appear as:

$$SourceConnection=SEBL_VERT_753

7 In the file TENERIFE_UPG_PARAMS.txt:

a Search for the parameter $$Source_Container.

b Set the value to one of the following options, based on your Siebel applications (OLTP) version:
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❏ Siebel 6.3

❏ Siebel 7.5.3

❏ Siebel 7.5.3 Vertical

❏ Siebel 7.7.1

❏ Siebel 7.7.1 Vertical

❏ Siebel 7.8

❏ Siebel 7.8 Vertical

❏ Siebel 8.0

❏ Siebel 8.0 Vertical

For example, if your Siebel applications (OLTP) version is Siebel Industry Applications 7.5.x, 
the parameter should appear as:

$$Source_Container=Siebel 7.5.3 Vertical

8 In the file TENERIFE_UPG_PARAMS.txt, edit the ETL_PROC_WID parameter as follows:

MPLT_GET_ETL_PROC_WID.$$ETL_PROC_WID=<latest ETL_PROC_WID value from your database>

You can get this value from W_PARAM_G.ETL_PROC_WID.

9 In the Informatica Workflow Manager, open the Relational Connection Browser (Connections > 
Relational), and do the following:

a Edit the preconfigured ODBC connection PARAM_OLTP_SIEBEL to point to the Siebel 
transactional database.

b Edit the preconfigured ODBC connection DataWarehouse to point to the newly upgraded data 
warehouse database.

c Edit the preconfigured ODBC connection PARAM_DAC_OLD to point to the previous DAC 
repository database (the version from which you are upgrading).

d Edit the preconfigured ODBC connection PARAM_DAC_NEW to point to the new DAC repository 
database (the version to which you are upgrading).
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10 In the Informatica Workflow Manager, navigate to the appropriate folder and execute the 
workflows in the order specified:

7 Run the Reset_infa_seq_gen.bat script to initialize the Informatica sequence generator for 
incremental runs:

a Navigate to the directory \OracleBI\dwrep\Upgrade\DbScripts\<database type>.

b Open the Reset_infa_seq_gen.bat script, and review the parameters at the top of the file.

Application 
Version Folder Name Workflow

 7.7 to 7.9 
(Horizontal)

UPGRADE_770_to_79 1 MARKETING_LOAD

2 Update_Dimensions

3 Update_Dimension_Unspecified

4 Update_Facts

5 SIL_PositionDimensionHierarchy_Full

6 Load_INT_ORG_DH

7 DIMENSION_LOAD

8 DIMENSION_UNSPECIFIED_UPDATE

9 FACT_UPDATE

10 DAC_Metadata_Upgrade_Workflow

7.7.1.x to 7.9 
(Horizontal)

UPGRADE_771_to_79 1 Update_Dimensions

2 Update_Dimension_Unspecified

3 Update_Facts

4 SIL_PositionDimensionHierarchy_Full

5 Load_INT_ORG_DH

6 DIMENSION_LOAD

7 DIMENSION_UNSPECIFIED_UPDATE

8 FACT_UPDATE

9 DAC_Metadata_Upgrade_Workflow

7.8 to 7.9 
(Horizontal)

UPGRADE_78_to_79 1 SIL_PositionDimensionHierarchy_Full

2 Load_INT_ORG_DH

3 DIMENSION_LOAD

4 DIMENSION_UNSPECIFIED_UPDATE

5 FACT_UPDATE

6 DAC_Metadata_Upgrade_Workflow
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c Replace the existing values for the parameters to reflect your environment (the parameters 
are database-specific).

For Oracle databases:

For Microsoft SQL Server databases:

Parameter Setting

TARGET_USERID_PWD <olap schema user-name>/<olap schema password>@<olap 
database TNS name> 

For example:

TARGET_USERID_PWD=siebel/siebel@siebel_olap

INFA_USERID_PWD <user-name of Informatica Repository database that 
contains the adapter mappings repository metadata>/
<password of the Informatica Repository database>@<TNS 
name of the database for the Informatica Repository>

For example:

INFA_USERID_PWD=INFAREP/INFAREP@infa.corp.siebel.com

INFA_REP Name of the Informatica Repository where the adapter 
mappings are available.

INFA_U User name of the administrator of the Informatica Repository.

INFA_P Password for the administrator of the Informatica Repository.

INFA_SRV Name of the Informatica Server.

Parameter Setting

OLAP_SERVER Name of the SQL Server for the OLAP database.

OLAP_DB Name of the database on which OLAP data is available.

OLAP_U User name for logging into the database on which OLAP data is 
available.

OLAP_P Password for logging into the database on which OLAP data is 
available.

INFA_SERVER Name of the SQL Server for the Informatica Repository 
database.

INFA_DB Name of the database on which Informatica Repository 
metadata is available.

INFA_U User name for logging into the database on which Informatica 
Repository metadata is available.

INFA_P Password for logging into the database on which Informatica 
Repository metadata is available.
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For IBM DB2 databases:

d Run the script.

NOTE: Because the Reset_infa_seq_gen.bat file contains user names and passwords, it is 
recommended that you delete the file after the upgrade process is complete.

8 To verify the data migrated successfully:

a Check whether any of the Informatica mapping log files stored in the directory \Informatica 
PowerCenter 7.1.4\Server\SessLogs indicates errors or failures.

b Check whether the SQL scripts (790_UPGRADE_PRE_CTL_SCRIPT.sql and 
790_UPGRADE_PRE_DIMENSION_SCRIPT.sql) that you ran in the SQL client of the database 
failed or errored out while executing.

c Check the log files for the CTL files (Upgrade.ctl and DW.ctl) that you ran using the DDLimp 
command to determine whether any of the runs failed.

If you did not detect any errors or failures in the steps above, then the data migration was 
successful.

INFA_REP Name of the Informatica Repository where adapter mappings 
are available.

INFA_REP_U User name of the administrator of the Informatica Repository.

INFA_REP_P Password of the administrator of the Informatica Repository.

Parameter Setting

TARGET_USERID_PWD <olap schema user-name>/<olap schema password>@<olap 
database name>

For example:

TARGET_USERID_PWD=siebel/db2@OLAP_DB2DB

INFA_USER User name for logging into the database on which Informatica 
metadata is available.

INFA_PWD Password for logging into the database on which Informatica 
Repository metadata is available.

INFADB_ALIAS Name of the database in which Informatica Repository 
metadata is available.

INFA_REP Name of the Informatica Repository where the adapter 
mappings are available.

INFA_U User name of the administrator of the Informatica Repository.

INFA_P Password of the administrator of the Informatica Repository.

INFA_SRV Name of the Informatica Server.

Parameter Setting
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9 (Optional) If the data migration was successful, drop the tables that were created during the 
upgrade process, such as, W_xxxx_x_784 tables, LKP_xxxx_x, and W_ASSET_D_TMP.

This step frees the space occupied by these backup tables.

To migrate data from version 7.5.x to 7.9 (Vertical)
NOTE: Upgrading from version 7.5.x requires two stages. In the first stage, you upgrade the data 
warehouse schema and migrate the data from version 7.5.x to 7.7. In the second stage, you upgrade 
the data warehouse schema and migrate the data from version 7.7 to 7.9.

1 Upgrade the data warehouse schema from version 7.5.x to 7.7 by using the DDLimp utility to run 
the script ddlsme_SIA_77.ctl script.

a Navigate to the folder OracleBI\dwrep\Upgrade\CTLFiles.

b Use the DDLimp utility to run the ddlsme_SIA_77.ctl script. Use the following command:

..\OracleBI\dwrep\bin\DDLIMP /U <USER> /P <PASSWORD> /C <ODBC connect string>
/G SSE_ROLE /R Y /F <..\OracleBI\dwrep\ddlsme_SIA_77.ctl>
/L <..\oracleBI\dwrep\ddlsme_SIA_77.log> 

For example: 

DDLIMP /U SADMIN /P SADMIN /C SIEBEL_OLTP /G SSE_ROLE
/R Y /F C:\OracleBI\dwrep\ddlsme_SIA_77.ctl /L 
C:\OracleBI\dwrep\ddlsme_SIA_77.log 

Notes: 

❏ /P <PASSWORD> - The password for Oracle’s CRM OLTP. 

❏ /C <ODBC connect string> - The name of the ODBC connect string. 

❏ For Oracle databases, use the Siebel Merant ODBC Drivers. 

❏ In addition, you can use the following commands: 

❏ /W Y - If the OLTP database is Oracle and Unicode.

❏ /Z Y - If the OLTP database is DB2 or SQL Server and Unicode. 

❏ /B <TABLE_SPACE_NAME> - If you want to create these tables in a separate table space. 
For DB2, This must be specified as 32K tablespace.

❏ /X <INDEX_TABLE_SPACE_NAME> - If you want to create the indexes in a separate 
tablespace. For DB2, This must be specified as 32K tablespace.

❏ /Y - Storage File for DB2/390.

❏ /R - Regrant tables.

2 Copy the file Upgrade.rep file from the folder OracleBI\dwrep\Upgrade\Informatica\Repository 
into the folder Informatica PowerCenter 7.1.4\RepositoryServer\bin\Backup.

3 Launch the Informatica Repository Console and restore Upgrade.rep (located in Informatica 
PowerCenter 7.1.4\RepositoryServer\bin\Backup).
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4 Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\ParameterFiles and copy the file 
753_TENERIFE_UPG_PARAMS.txt into the SrcFiles directory on the Informatica Server machine, 
for example, C:\Program Files\Informatica PowerCenter 7.1.4\Server\SrcFiles.

5 Rename the file 753_TENERIFE_UPG_PARAMS.txt to TENERIFE_UPG_PARAMS.txt.

6 In Informatica Workflow Manager, navigate to the folder UPGRADE_753_to_770_SIA, and 
execute the following workflows in the order indicated:

a Upgrade_R_Image

b Upgrade_Unspecifieds

c Upgrade_Agree

d Upgrade_Asset

e Upgrade_Opty

f Upgrade_Order

g Upgrade_Quote

h Upgrade_Response

i Upgrade_ServiceRequest

j Upgrade_Others

k Upgrade_Visibility

l UpgradeSlowlyChangingDimensionStartDates

m Upgrade_Industry_R_Image

n Upgrade_Industry_Unspecified

o Upgrade_LS_ActivityProduct

p Upgrade_LS_Others

q Upgrade_Industry_Household

r Upgrade_FINS_Visibility

s UpgradeSlowlyChangingDimensionStartDates_Industry

t DAC_Metadata_Upgrade_Workflow

7 Upgrade the data warehouse schema from version 7.7 to 7.9 by following the steps in the 
procedure “To upgrade the data warehouse schema” on page 20.

8 Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\SrcFiles and copy the *.csv files into 
the SrcFiles folder on the Informatica Server machine, for example, C:\Program 
Files\Informatica PowerCenter 7.1.4\Server\SrcFiles.

9 Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\ParameterFiles and copy the file 
770_TENERIFE_UPG_PARAMS.txt into the SrcFiles folder on the Informatica Server machine, for 
example, C:\Program Files\Informatica PowerCenter 7.1.4\Server\SrcFiles.

10 Rename 770_TENERIFE_UPG_PARAMS.txt to TENERIFE_UPG_PARAMS.txt.

11 In the file TENERIFE_UPG_PARAMS.txt:
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a Search for the parameter $$SourceConnection.

b Set the value to one of the following options, based on your Siebel applications (OLTP) version:

❏ SEBL_63

❏ SEBL_753

❏ SEBL_771

❏ SEBL_78

❏ SEBL_80

❏ SEBL_VERT_753

❏ SEBL_VERT_771

❏ SEBL_VERT_78

❏ SEBL_VERT_80

For example, if your Siebel applications (OLTP) version is Siebel Industry Applications 7.5.x, 
the parameter should appear as:

$$SourceConnection=SEBL_VERT_753

12 In the file TENERIFE_UPG_PARAMS.txt:

a Search for the parameter $$Source_Container.

b Set the value to one of the following options, based on your Siebel applications (OLTP) version:

❏ Siebel 6.3

❏ Siebel 7.5.3

❏ Siebel 7.5.3 Vertical

❏ Siebel 7.7.1

❏ Siebel 7.7.1 Vertical

❏ Siebel 7.8

❏ Siebel 7.8 Vertical

❏ Siebel 8.0

❏ Siebel 8.0 Vertical

For example, if your Siebel applications (OLTP) version is Siebel Industry Applications 7.5.x, 
the parameter should appear as:

$$Source_Container=Siebel 7.5.3 Vertical

13 In the file TENERIFE_UPG_PARAMS.txt, edit the ETL_PROC_WID parameter as follows:

MPLT_GET_ETL_PROC_WID.$$ETL_PROC_WID=<latest ETL_PROC_WID value from your database>

You can get this value from W_PARAM_G.ETL_PROC_WID.

14 In the Informatica Workflow Manager, open the Relational Connection Browser (Connections > 
Relational), and do the following:
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a Edit the preconfigured ODBC connection PARAM_OLTP_SIEBEL to point to the Siebel 
transactional database.

b Edit the preconfigured ODBC connection DataWarehouse to point to the newly upgraded data 
warehouse database.

c Edit the preconfigured ODBC connection PARAM_DAC_OLD to point to the previous DAC 
repository database (the version from which you are upgrading).

d Edit the preconfigured ODBC connection PARAM_DAC_NEW to point to the new DAC repository 
database (the version to which you are upgrading).

15 Define the alignment rule to be used for ETL loads. 

a Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\SrcFiles and copy the file 
AlignmentType_LS_782.csv into the SrcFiles folder on the Informatica Server machine, for 
example, C:\Program Files\Informatica PowerCenter 7.1.4\Server\SrcFiles.

b Rename the file AlignmentType_LS_782.csv to AlignmentType.csv.

c Open the file AlignmentType.csv, and enter one of the following alignment item types under the 
ALIGN_TYPE field:

❏ Zipcode

❏ Account/Contact

❏ Brick

d Save the file.

NOTE: The Oracle Business Analytics Warehouse allows only one alignment type to be used for 
ETL loads during upgrade.

16 In Informatica Workflow Manager, navigate to the folder UPGRADE_770_to_79, and execute the 
following workflows in the order indicated:

a MARKETING_LOAD

b Upgrade_Dimensions_Industry

c Update_Dimensions

d Update_Dimension_Unspecified

e Update_Facts

f Upgrade_LS_Dimensions

g Upgrade_LS_Facts

h SIL_PositionDimensionHierarchy_Full

i Load_INT_ORG_DH

j DIMENSION_LOAD

k DIMENSION_UNSPECIFIED_UPDATE

l FACT_UPDATE

17 Run the Reset_infa_seq_gen.bat script to initialize the Informatica sequence generator for 
incremental runs:
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a Navigate to the directory \OracleBI\dwrep\Upgrade\DbScripts\<database type>.

b Open the Reset_infa_seq_gen.bat script, and review the parameters at the top of the file.
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c Replace the existing values for the parameters to reflect your environment (the parameters 
are database-specific).

For Oracle databases:

For Microsoft SQL Server databases:

Parameter Setting

TARGET_USERID_PWD <olap schema user-name>/<olap schema password>@<olap 
database TNS name> 

For example:

TARGET_USERID_PWD=siebel/siebel@siebel_olap

INFA_USERID_PWD <user-name of Informatica Repository database that 
contains the adapter mappings repository metadata>/
<password of the Informatica Repository database>@<TNS 
name of the database for the Informatica Repository>

For example:

INFA_USERID_PWD=INFAREP/INFAREP@infa.corp.siebel.com

INFA_REP Name of the Informatica Repository where the adapter 
mappings are available.

INFA_U User name of the administrator of the Informatica Repository.

INFA_P Password for the administrator of the Informatica Repository.

INFA_SRV Name of the Informatica Server.

Parameter Setting

OLAP_SERVER Name of the SQL Server for the OLAP database.

OLAP_DB Name of the database on which OLAP data is available.

OLAP_U User name for logging into the database on which OLAP data is 
available.

OLAP_P Password for logging into the database on which OLAP data is 
available.

INFA_SERVER Name of the SQL Server for the Informatica Repository 
database.

INFA_DB Name of the database on which Informatica Repository 
metadata is available.

INFA_U User name for logging into the database on which Informatica 
Repository metadata is available.

INFA_P Password for logging into the database on which Informatica 
Repository metadata is available.
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For IBM DB2 databases:

d Run the script.

NOTE: Because the Reset_infa_seq_gen.bat file contains user names and passwords, it is 
recommended that you delete the file after the upgrade process is complete.

18 To verify the data migrated successfully:

a Check whether any of the Informatica mapping log files stored in the directory \Informatica 
PowerCenter 7.1.4\Server\SessLogs indicates errors or failures.

b Check whether the SQL scripts (790_UPGRADE_PRE_CTL_SCRIPT.sql and 
790_UPGRADE_PRE_DIMENSION_SCRIPT.sql) that you ran in the SQL client of the database 
failed or errored out while executing.

c Check the log files for the CTL files (Upgrade.ctl and DW.ctl) that you ran using the DDLimp 
command to determine whether any of the runs failed.

If you did not detect any errors or failures in the steps above, then the data migration was 
successful.

INFA_REP Name of the Informatica Repository where adapter mappings 
are available.

INFA_REP_U User name of the administrator of the Informatica Repository.

INFA_REP_P Password of the administrator of the Informatica Repository.

Parameter Setting

TARGET_USERID_PWD <olap schema user-name>/<olap schema password>@<olap 
database name>

For example:

TARGET_USERID_PWD=siebel/db2@OLAP_DB2DB

INFA_USER User name for logging into the database on which Informatica 
metadata is available.

INFA_PWD Password for logging into the database on which Informatica 
Repository metadata is available.

INFADB_ALIAS Name of the database in which Informatica Repository 
metadata is available.

INFA_REP Name of the Informatica Repository where the adapter 
mappings are available.

INFA_U User name of the administrator of the Informatica Repository.

INFA_P Password of the administrator of the Informatica Repository.

INFA_SRV Name of the Informatica Server.

Parameter Setting
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19 (Optional) If the data migration was successful, drop the tables that were created during the 
upgrade process, such as, W_xxxx_x_784 tables, LKP_xxxx_x, and W_ASSET_D_TMP.

This step frees the space occupied by these backup tables.

To migrate data from versions 7.7, 7.7.1.x, or 7.8 to 7.9 (Vertical)

1 Copy the file Upgrade.rep file from the folder OracleBI\dwrep\Upgrade\Informatica\Repository 
into the folder Informatica PowerCenter 7.1.4\RepositoryServer\bin\Backup.

2 Launch the Informatica Repository Console and restore Upgrade.rep (located in Informatica 
PowerCenter 7.1.4\RepositoryServer\bin\Backup).

3 Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\SrcFiles and copy the *.csv files into 
the SrcFiles folder on the Informatica Server machine, for example, C:\Program 
Files\Informatica PowerCenter 7.1.4\Server\SrcFiles.

4 Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\ParameterFiles and copy the file 
<previous version of Siebel Analytics>_TENERIFE_UPG_PARAMS.txt into the SrcFiles folder on 
the Informatica Server machine, for example, C:\Program Files\Informatica PowerCenter 
7.1.4\Server\SrcFiles.

5 Rename the file <previous version of Siebel Analytics>_TENERIFE_UPG_PARAMS.txt to 
TENERIFE_UPG_PARAMS.txt.

6 In the file TENERIFE_UPG_PARAMS.txt:

a Search for the parameter $$SourceConnection.

b Set the value to one of the following options, based on your Siebel applications (OLTP) version:

❏ SEBL_63

❏ SEBL_753

❏ SEBL_771

❏ SEBL_78

❏ SEBL_80

❏ SEBL_VERT_753

❏ SEBL_VERT_771

❏ SEBL_VERT_78

❏ SEBL_VERT_80

For example, if your Siebel applications (OLTP) version is Siebel Industry Applications 7.5.x, 
the parameter should appear as:

$$SourceConnection=SEBL_VERT_753

7 In the file TENERIFE_UPG_PARAMS.txt:

a Search for the parameter $$Source_Container.

b Set the value to one of the following options, based on your Siebel applications (OLTP) version:
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❏ Siebel 6.3

❏ Siebel 7.5.3

❏ Siebel 7.5.3 Vertical

❏ Siebel 7.7.1

❏ Siebel 7.7.1 Vertical

❏ Siebel 7.8

❏ Siebel 7.8 Vertical

❏ Siebel 8.0

❏ Siebel 8.0 Vertical

For example, if your Siebel applications (OLTP) version is Siebel Industry Applications 7.5.x, 
the parameter should appear as:

$$Source_Container=Siebel 7.5.3 Vertical

8 In the file TENERIFE_UPG_PARAMS.txt, edit the ETL_PROC_WID parameter as follows:

MPLT_GET_ETL_PROC_WID.$$ETL_PROC_WID=<latest ETL_PROC_WID value from your database>

You can get this value from W_PARAM_G.ETL_PROC_WID.

9 In the Informatica Workflow Manager, open the Relational Connection Browser (Connections > 
Relational), and do the following:

a Edit the preconfigured ODBC connection PARAM_OLTP_SIEBEL to point to the Siebel 
transactional database.

b Edit the preconfigured ODBC connection DataWarehouse to point to the newly upgraded data 
warehouse database.

c Edit the preconfigured ODBC connection PARAM_DAC_OLD to point to the previous DAC 
repository database (the version from which you are upgrading).

d Edit the preconfigured ODBC connection PARAM_DAC_NEW to point to the new DAC repository 
database (the version to which you are upgrading).

10 Define the alignment rule to be used for ETL loads. 

a Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\SrcFiles and copy the file 
AlignmentType_LS_782.csv into the SrcFiles folder on the Informatica Server machine, for 
example, C:\Program Files\Informatica PowerCenter 7.1.4\Server\SrcFiles.

b Rename the file AlignmentType_LS_782.csv to AlignmentType.csv.

c Open the file AlignmentType.csv, and enter one of the following alignment item types under the 
ALIGN_TYPE field:

❏ Zipcode

❏ Account/Contact

❏ Brick
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d Save the file.

NOTE: The Oracle Business Analytics Warehouse allows only one alignment type to be used for 
ETL loads during upgrade.

11 In Informatica Workflow Manager, navigate to the appropriate folder and execute the workflows 
in the order specified:

Application 
Version Folder Name Workflow

 7.7 to 7.9 
(Vertical)

UPGRADE_770_to_79 1 MARKETING_LOAD

2 Upgrade_Dimensions_Industry

3 Update_Dimensions

4 Update_Dimension_Unspecified

5 Update_Facts

6 Upgrade_LS_Dimensions

7 Upgrade_LS_Facts

8 SIL_PositionDimensionHierarchy_Full

9 Load_INT_ORG_DH

10 DIMENSION_LOAD

11 DIMENSION_UNSPECIFIED_UPDATE

12 FACT_UPDATE

13 DAC_Metadata_Upgrade_Workflow
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7 Run the Reset_infa_seq_gen.bat script to initialize the Informatica sequence generator for 
incremental runs:

a Navigate to the directory \OracleBI\dwrep\Upgrade\DbScripts\<database type>.

b Open the Reset_infa_seq_gen.bat script, and review the parameters at the top of the file.

7.7.1.x to 7.9 
(Vertical)

UPGRADE_771_to_79 1 Update_Dimensions

2 Update_Dimension_Unspecified

3 Update_Facts

4 Upgrade_LS_Dimensions

5 Upgrade_LS_Facts

6 SIL_PositionDimensionHierarchy_Full

7 Load_INT_ORG_DH

8 DIMENSION_LOAD

9 DIMENSION_UNSPECIFIED_UPDATE

10 FACT_UPDATE

11 DAC_Metadata_Upgrade_Workflow

7.8 to 7.9 
(Vertical)

UPGRADE_78_to_79 1 SIL_PositionDimensionHierarchy_Full

2 Load_INT_ORG_DH

3 DIMENSION_LOAD

4 DIMENSION_UNSPECIFIED_UPDATE

5 FACT_UPDATE

6 DAC_Metadata_Upgrade_Workflow

Application 
Version Folder Name Workflow
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c Replace the existing values for the parameters to reflect your environment (the parameters 
are database-specific).

For Oracle databases:

For Microsoft SQL Server databases:

Parameter Setting

TARGET_USERID_PWD <olap schema user-name>/<olap schema password>@<olap 
database TNS name> 

For example:

TARGET_USERID_PWD=siebel/siebel@siebel_olap

INFA_USERID_PWD <user-name of Informatica Repository database that 
contains the adapter mappings repository metadata>/
<password of the Informatica Repository database>@<TNS 
name of the database for the Informatica Repository>

For example:

INFA_USERID_PWD=INFAREP/INFAREP@infa.corp.siebel.com

INFA_REP Name of the Informatica Repository where the adapter 
mappings are available.

INFA_U User name of the administrator of the Informatica Repository.

INFA_P Password for the administrator of the Informatica Repository.

INFA_SRV Name of the Informatica Server.

Parameter Setting

OLAP_SERVER Name of the SQL Server for the OLAP database.

OLAP_DB Name of the database on which OLAP data is available.

OLAP_U User name for logging into the database on which OLAP data is 
available.

OLAP_P Password for logging into the database on which OLAP data is 
available.

INFA_SERVER Name of the SQL Server for the Informatica Repository 
database.

INFA_DB Name of the database on which Informatica Repository 
metadata is available.

INFA_U User name for logging into the database on which Informatica 
Repository metadata is available.

INFA_P Password for logging into the database on which Informatica 
Repository metadata is available.
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For IBM DB2 databases:

d Run the script.

NOTE: Because the Reset_infa_seq_gen.bat file contains user names and passwords, it is 
recommended that you delete the file after the upgrade process is complete.

8 To verify the data migrated successfully:

a Check whether any of the Informatica mapping log files stored in the directory \Informatica 
PowerCenter 7.1.4\Server\SessLogs indicates errors or failures.

b Check whether the SQL scripts (790_UPGRADE_PRE_CTL_SCRIPT.sql and 
790_UPGRADE_PRE_DIMENSION_SCRIPT.sql) that you ran in the SQL client of the database 
failed or errored out while executing.

c Check the log files for the CTL files (Upgrade.ctl and DW.ctl) that you ran using the DDLimp 
command to determine whether any of the runs failed.

If you did not detect any errors or failures in the steps above, then the data migration was 
successful.

INFA_REP Name of the Informatica Repository where adapter mappings 
are available.

INFA_REP_U User name of the administrator of the Informatica Repository.

INFA_REP_P Password of the administrator of the Informatica Repository.

Parameter Setting

TARGET_USERID_PWD <olap schema user-name>/<olap schema password>@<olap 
database name>

For example:

TARGET_USERID_PWD=siebel/db2@OLAP_DB2DB

INFA_USER User name for logging into the database on which Informatica 
metadata is available.

INFA_PWD Password for logging into the database on which Informatica 
Repository metadata is available.

INFADB_ALIAS Name of the database in which Informatica Repository 
metadata is available.

INFA_REP Name of the Informatica Repository where the adapter 
mappings are available.

INFA_U User name of the administrator of the Informatica Repository.

INFA_P Password of the administrator of the Informatica Repository.

INFA_SRV Name of the Informatica Server.

Parameter Setting
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9 (Optional) If the data migration was successful, drop the tables that were created during the 
upgrade process, such as, W_xxxx_x_784 tables, LKP_xxxx_x, and W_ASSET_D_TMP.

This step frees the space occupied by these backup tables.

To migrate data from Life Sciences 7.8.0, 7.8.1 or 7.8.2 to 7.9

1 Copy the file Upgrade.rep file from the folder OracleBI\dwrep\Upgrade\Informatica\Repository 
into the folder Informatica PowerCenter 7.1.4\RepositoryServer\bin\Backup.

2 Launch the Informatica Repository Console and restore Upgrade.rep (located in Informatica 
PowerCenter 7.1.4\RepositoryServer\bin\Backup).

3 Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\SrcFiles and copy the *.csv files into 
the SrcFiles folder on the Informatica Server machine, for example, C:\Program 
Files\Informatica PowerCenter 7.1.4\Server\SrcFiles.

4 Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\ParameterFiles and copy the file 
782_TENERIFE_UPG_PARAMS_LS.txt into the SrcFiles folder on the Informatica Server machine, 
for example, C:\Program Files\Informatica PowerCenter 7.1.4\Server\SrcFiles.

5 Rename the file 782_TENERIFE_UPG_PARAMS_LS.txt to TENERIFE_UPG_PARAMS.txt.

6 In the file TENERIFE_UPG_PARAMS.txt:

a Search for the parameter $$SourceConnection.

b Set the value to one of the following options, based on your Siebel applications (OLTP) version:

❏ SEBL_63

❏ SEBL_753

❏ SEBL_771

❏ SEBL_78

❏ SEBL_80

❏ SEBL_VERT_753

❏ SEBL_VERT_771

❏ SEBL_VERT_78

❏ SEBL_VERT_80

For example, if your Siebel applications (OLTP) version is Siebel Industry Applications 7.5.x, 
the parameter should appear as:

$$SourceConnection=SEBL_VERT_753

7 In the file TENERIFE_UPG_PARAMS.txt:

a Search for the parameter $$Source_Container.

b Set the value to one of the following options, based on your Siebel applications (OLTP) version:

❏ Siebel 6.3

❏ Siebel 7.5.3
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❏ Siebel 7.5.3 Vertical

❏ Siebel 7.7.1

❏ Siebel 7.7.1 Vertical

❏ Siebel 7.8

❏ Siebel 7.8 Vertical

❏ Siebel 8.0

❏ Siebel 8.0 Vertical

For example, if your Siebel applications (OLTP) version is Siebel Industry Applications 7.5.x, 
the parameter should appear as:

$$Source_Container=Siebel 7.5.3 Vertical

8 In the file TENERIFE_UPG_PARAMS.txt, edit the ETL_PROC_WID parameter as follows:

MPLT_GET_ETL_PROC_WID.$$ETL_PROC_WID=<latest ETL_PROC_WID value from your database>

You can get this value from W_PARAM_G.ETL_PROC_WID.

9 In the Informatica Workflow Manager, open the Relational Connection Browser (Connections > 
Relational), and do the following:

a Edit the preconfigured ODBC connection PARAM_OLTP_SIEBEL to point to the Siebel 
transactional database.

b Edit the preconfigured ODBC connection DataWarehouse to point to the newly upgraded data 
warehouse database.

c Edit the preconfigured ODBC connection PARAM_DAC_OLD to point to the previous DAC 
repository database (the version from which you are upgrading).

d Edit the preconfigured ODBC connection PARAM_DAC_NEW to point to the new DAC repository 
database (the version to which you are upgrading).

10 Define the alignment rule to be used for ETL loads. 

a Navigate to the folder OracleBI\dwrep\Upgrade\Informatica\SrcFiles and copy the file 
AlignmentType_LS_782.csv into the SrcFiles folder on the Informatica Server machine, for 
example, C:\Program Files\Informatica PowerCenter 7.1.4\Server\SrcFiles.

b Rename the file AlignmentType_LS_782.csv to AlignmentType.csv.

c Open the file AlignmentType.csv, and enter one of the following alignment item types under the 
ALIGN_TYPE field:

❏ Zipcode

❏ Account/Contact

❏ Brick

d Save the file.

NOTE: The Oracle Business Analytics Warehouse allows only one alignment type to be used for 
ETL loads during upgrade.
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11 In Informatica Workflow Manager, navigate to the folder UPGRADE_LS_782_to_79, and execute 
the following workflows in the order indicated:

a Upgrade_LS_Dimensions

b Upgrade_LS_Facts

c SIL_PositionDimensionHierarchy_Full

d Load_INT_ORG_DH

e DIMENSION_LOAD

f DIMENSION_UNSPECIFIED_UPDATE

g FACT_UPDATE

h DAC_Metadata_Upgrade_Workflow

12 Run the Reset_infa_seq_gen.bat script to initialize the Informatica sequence generator for 
incremental runs:

a Navigate to the directory \OracleBI\dwrep\Upgrade\DbScripts\<database type>.

b Open the Reset_infa_seq_gen.bat script, and review the parameters at the top of the file.
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c Replace the existing values for the parameters to reflect your environment (the parameters 
are database-specific).

For Oracle databases:

For Microsoft SQL Server databases:

Parameter Setting

TARGET_USERID_PWD <olap schema user-name>/<olap schema password>@<olap 
database TNS name> 

For example:

TARGET_USERID_PWD=siebel/siebel@siebel_olap

INFA_USERID_PWD <user-name of Informatica Repository database that 
contains the adapter mappings repository metadata>/
<password of the Informatica Repository database>@<TNS 
name of the database for the Informatica Repository>

For example:

INFA_USERID_PWD=INFAREP/INFAREP@infa.corp.siebel.com

INFA_REP Name of the Informatica Repository where the adapter 
mappings are available.

INFA_U User name of the administrator of the Informatica Repository.

INFA_P Password for the administrator of the Informatica Repository.

INFA_SRV Name of the Informatica Server.

Parameter Setting

OLAP_SERVER Name of the SQL Server for the OLAP database.

OLAP_DB Name of the database on which OLAP data is available.

OLAP_U User name for logging into the database on which OLAP data is 
available.

OLAP_P Password for logging into the database on which OLAP data is 
available.

INFA_SERVER Name of the SQL Server for the Informatica Repository 
database.

INFA_DB Name of the database on which Informatica Repository 
metadata is available.

INFA_U User name for logging into the database on which Informatica 
Repository metadata is available.

INFA_P Password for logging into the database on which Informatica 
Repository metadata is available.
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For IBM DB2 databases:

d Run the script.

NOTE: Because the Reset_infa_seq_gen.bat file contains user names and passwords, it is 
recommended that you delete the file after the upgrade process is complete.

13 To verify the data migrated successfully:

a Check whether any of the Informatica mapping log files stored in the directory \Informatica 
PowerCenter 7.1.4\Server\SessLogs indicates errors or failures.

b Check whether the SQL scripts (790_UPGRADE_PRE_CTL_SCRIPT.sql and 
790_UPGRADE_PRE_DIMENSION_SCRIPT.sql) that you ran in the SQL client of the database 
failed or errored out while executing.

c Check the log files for the CTL files (Upgrade.ctl and DW.ctl) that you ran using the DDLimp 
command to determine whether any of the runs failed.

If you did not detect any errors or failures in the steps above, then the data migration was 
successful.

INFA_REP Name of the Informatica Repository where adapter mappings 
are available.

INFA_REP_U User name of the administrator of the Informatica Repository.

INFA_REP_P Password of the administrator of the Informatica Repository.

Parameter Setting

TARGET_USERID_PWD <olap schema user-name>/<olap schema password>@<olap 
database name>

For example:

TARGET_USERID_PWD=siebel/db2@OLAP_DB2DB

INFA_USER User name for logging into the database on which Informatica 
metadata is available.

INFA_PWD Password for logging into the database on which Informatica 
Repository metadata is available.

INFADB_ALIAS Name of the database in which Informatica Repository 
metadata is available.

INFA_REP Name of the Informatica Repository where the adapter 
mappings are available.

INFA_U User name of the administrator of the Informatica Repository.

INFA_P Password of the administrator of the Informatica Repository.

INFA_SRV Name of the Informatica Server.

Parameter Setting
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14 (Optional) If the data migration was successful, drop the tables that were created during the 
upgrade process, such as, W_xxxx_x_784 tables, LKP_xxxx_x, and W_ASSET_D_TMP.

This step frees the space occupied by these backup tables.

Verifying ETL Customizations
While upgrading the Informatica repository, you copied the Custom folder, which contained your 
mapping customizations, from your previous Informatica repository to the newly created Informatica 
repository. Then, when you migrated data, you ran an incremental load, which populated data 
warehouse entities. Now, to verify that your custom mappings were upgraded successfully, check the 
DAC and Informatica log files to confirm there were no errors during the incremental load process.

Process of Upgrading the Siebel 
Analytics Repository
This process merges your customizations of a prior release of the Siebel Analytics repository with 
the new version of the Oracle BI repository. Before you begin this process, make sure you have 
backed up and renamed your existing Analytics repository.

To upgrade the repository, perform the following tasks:

■ Preparing for the Analytics Repository Upgrade on page 53

■ Equalizing the Analytics Repositories on page 54

■ Comparing the Analytics Repositories on page 55

■ Merging the Analytics Repositories on page 55

■ Regression Testing the Analytics Repository Merge on page 57

The tasks in this section refer to multiple versions of the Analytics repository. Table 4 provides the 
names and descriptions of the repositories used in the examples in this section.

Table 4. Names of Analytics Repositories used in Examples

Name of Repository Description

SiebelAnalytics_7x.rpd The standard Siebel Analytics repository for the 
version you are upgrading from.

NOTE: Standard Siebel Analytics repositories 
from previous releases are available in the folder 
\OracleBI\Upgrade.

OracleBIAnalyticsApps.rpd The standard Oracle Business Intelligence 
repository for the version you are upgrading to.
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Preparing for the Analytics Repository Upgrade
Follow this procedure to prepare for the repository upgrade.

To prepare for the Analytics repository upgrade

1 Set up a directory for the merge process, such as \OracleBIUpgrade, and create the following 
subfolders:

■ Original

■ AfterEqualize

■ AfterMerge

■ AfterManualWork

■ AfterRegressions

2 Copy the original repository (for example, SiebelAnalytics_7x.rpd), the production repository (for 
example, Customer_SiebelAnalytics.rpd), and the repository from the latest installation (for 
example, OracleBIAnalyticsApps.rpd) into the folder \OracleBIUpgrade\Original.

NOTE: If in your current environment you are running Siebel Business Analytics for one or more 
modules using a Siebel Analytics repository in which you extracted the corresponding projects 
for the modules from the standard Siebel Analytics repository file you received from the previous 
release, you need to extract the same projects from the SiebelAnalytics_7x.rpd file and use this 
as your original repository. (If you have the original repository that you extracted during the last 
upgrade, you can use it as the original repository file.) This will prevent you from losing any new 
metadata you would like to add in this upgrade.

Also, if you customized the Siebel Analytics repository by trimming a large number of objects and 
you would like to get those objects back during the current upgrade, you need to trim the 
SiebelAnalytics_7x.rpd file in the same way and use the modified version as the original 
repository file. This will prevent you from losing any new metadata you would like to add in this 
upgrade.

Customer_SiebelAnalytics.rpd The Siebel Analytics repository that contains your 
customizations for the version you are upgrading 
from.

Merged_Repository_OracleBI.rpd The Oracle Business Intelligence repository that 
contains your customizations for the version you 
are upgrading to.

Table 4. Names of Analytics Repositories used in Examples

Name of Repository Description
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Equalizing the Analytics Repositories
The Merge feature in the Administration Tool relies on a change detection algorithm to determine the 
changes that need to be made to upgrade repositories correctly. For the algorithm to work correctly, 
it has to determine which objects in the three repositories (for example, SiebelAnalytics_7x.rpd, 
OracleBIAnalyticsApps.rpd, and Customer_SiebelAnalytics.rpd) are equivalent.

The point of this step is to determine for every object in the OracleBIAnalyticsApps.rpd and the 
Customer_SiebelAnalytics.rpd whether it is coming from the SiebelAnalytics_7x.rpd. 

Equivalence between objects is established using the Administration Tool’s Equalize feature. The file 
that you specify in the Output option (-O) is the only file that is modified during the equalization 
process.

The Equalize feature has several mechanisms for determining whether an object in two different 
repositories is semantically the same:

■ Fully Qualified Name. If an object in one repository has the same fully qualified name as 
another object of the same class in another repository, then the two objects are declared equal.

■ Simple String Substitution. Equivalence can be declared between two objects of the same 
class in two repositories whose only difference is that some key characters in their names differ. 
The equalizerpds executable file ignores those characters while checking fully qualified names. 
For example, "Core"."W_DAY_D" might be considered equivalent to "Core"."W DAY D" if the 
characters "_" and " " have been declared as equivalent.

■ Rename File. When none of the preceding rules are applicable, equivalence can be manually 
declared using a script as input to the equalizerpds executable file. Oracle ships the rename files 
(MAP) for the major releases. The files are located in the OracleBI\Upgrade folder. You can also 
create your own rename files for customizations not covered in the files that Oracle ships. You 
can open and edit the rename files in Microsoft Excel. 

The syntax of the equalizerpds command is as follows:

equalizerpds.exe  -A userid1 [-B [password1]] -C base_repository_name -D userid2 [-E 
[password2]] -F repository2_name [-J udml_utf8_file_name_equalization] [-O 
ouput_repository_name] [-X] [-Y equalStringSet]

-X          Treat 'Factxxxx' as 'Fact' in Business Model.

-Y          Treat the characters as equals.

/?          Display this usage information and exit.

To equalize a repository

1 Copy the appropriate MAP file from the OracleBI\Upgrade folder into the folder where you will 
execute equalizerpds.exe, for example, \OracleBIUpgrade\Original.

2 Run equalizerpds.exe to equalize the repository from the latest installation (for example, 
OracleBIAnalyticsApps.rpd) with the original repository (for example, SiebelAnalytics_7x.rpd). 
An example of the equalizerpds command is as follows:
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equalizerpds -A Administrator -B SADMIN
-C \\OracleBIUpgrade\Original\SiebelAnalytics_7x.rpd
-D Administrator -E SADMIN
-F \\OracleBIUpgrade\Original\OracleBIAnalyticsApps.rpd
-O \\OracleBIAnalyticsUpgrade\AfterEqualize\OracleBIAnalyticsApps.rpd
-X -J rename7x-79.map

The MAP files are located in the \OracleBI\Upgrade folder.

If the equalizerpds.exe executable file runs correctly, no errors are returned.

3 Run equalizerpds.exe to equalize your customized repository (for example, 
Customer_SiebelAnalytics.rpd) with the original repository (for example, 
SiebelAnalytics_7x.rpd). An example of the equalizerpds command is as follows:

equalizerpds -A Administrator -B SADMIN
-C \\OracleBIUpgrade\Original\SiebelAnalytics_7x.rpd
-D Administrator -E SADMIN
-F \\OracleBIUpgrade\Original\Customer_SiebelAnalytics.rpd
-O \\OracleBIUpgrade\AfterEqualize\Customer_SiebelAnalytics.rpd

The execution of equalizerpds that equalizes the customer repository with the original repository 
does not use the rename file.

Make sure that the original repository is copied unchanged into its new location so that after 
running the script, all three repositories are contained within the \OracleBIUpgrade\AfterEqualize 
directory.

4 To verify the process completed successfully, compare the size of the repositories. The output 
repository (-O) should be close to the same size as the repository you equalized (-F).

Comparing the Analytics Repositories
Follow this procedure to compare your existing repository with the new version to which you are 
upgrading.

To compare the Analytics repositories
■ Use the Administration Tool’s Compare Repositories feature to analyze the differences between 

your existing repository and the new version of the repository to which you are upgrading. Note 
where elements have been created, removed, or changed in the new version. Consider whether 
you can use the new metadata and retire customizations you made in the existing repository.

For instructions on how to use the Administration Tool’s Compare Repositories feature, see Oracle 
Business Intelligence Server Administration Guide.

Merging the Analytics Repositories
In this procedure, you execute the main algorithm to upgrade the repository. For more information 
on merging the repositories, see Oracle Business Intelligence Server Administration Guide.
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To merge versions of the Analytics repositories

1 Copy the three repositories (for example, SiebelAnalytics_7x.rpd, OracleBIAnalyticsApps.rpd, 
and Customer_SiebelAnalytics.rpd) to the AfterMerge folder. 

2 Open the repository from the latest installation (for example, OracleBIAnalyticsApps.rpd) in the 
\OracleBIUpgrade\AfterMerge folder.

3 Save the repository with a new name, for example, 
Merged_Repository_OracleBIAnalyticsApps.rpd.

This new repository will contain the final results of the upgrade.

4 From the Administration Tool menu bar, choose File > Merge.

5 In the Select Original Repository dialog box, select the original repository (for example, 
SiebelAnalytics_7x.rpd).

6 Enter the password, and click OK.

7 Click Select for the Modified Repository field.

8 In the Select Modified Repository dialog box, select the repository that contains the 
customizations you made to the previous version of the Analytics repository.

9 Click Open, type the password, and then click OK.

10 In the Decision drop-down list, select the action you want to take regarding the repository 
change, or accept the default action.

11 To locate subsequent rows with empty Decision fields, click the Decision header cell.

When all rows have a value in the Decision field, the Merge button is enabled.

12 Click Merge.

This process can take up to 40 minutes, depending on the size of the repositories you are working 
with. A message will alert you when the merge is complete.

13 Click Yes when asked if you want to run a consistency check.

The number of errors returned by the consistency check is an indication of how successful the 
merge process was. If you receive many errors, for example, over 300, you should analyze the 
reason for the errors. If the merge process failed to recognize that two objects are the same, 
you may need to edit the rename file if the object is in the Current repository, or add your own 
rename file if you have renamed many of the objects and the upgrade engine failed to relate 
them to the original objects.

You also may need to change the actions you selected in the Decision drop-down list before 
rerunning the merge. This could save you time by reducing the number of errors that you will 
need to fix manually.

Once you are satisfied with the results of the merge, you should fix the remaining errors 
manually. It is important that you fix all errors before moving on to the next step. This repository 
serves as the input for the next stage.

You should also check that all of your customized objects are present and that no duplicate 
physical tables were introduced. To check for duplicate tables, search for physical tables using a 
query such as:
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where name like ‘*#1’

14 Copy the repository to the folder \OracleBIUpgrade\AfterManualWork.

Regression Testing the Analytics Repository Merge
In performing a regression test for the repository merge, the objective is to collect a set of logical 
SQL statements that are used for reports and to verify that they continue to work with the new 
metadata. For this purpose, it is recommended that you perform the following procedure.

To perform regression testing

1 Run the reports that are necessary to include in the regression suite. These reports might be a 
subset of the reports in the Presentation Catalog.

2 Collect the logical SQL generated in the previous step. You can do this using Usage Tracking or 
by parsing the query log file.

For information about Usage Tracking, see Oracle Business Intelligence Server Administration 
Guide.

3 Execute the logical SQL against the old repository using the command line utility nQCmd.exe 
located in \OracleBI\server\bin, and save the results to a file.

For information about the nQCmd.exe utility, see Oracle Business Intelligence Server 
Administration Guide.

4 Edit the logical SQL test scripts to account for the name changes or modifications resulting from 
the upgrade.

5 Execute the edited logical SQL against the merged repository, and save the results.

6 Compare the results from the steps above and try to explain the differences. If it is determined 
that these differences are due to the upgrade process, then you have to correct them manually.

This repository now contains the merged content from the new OracleBIAnalyticsApps.rpd and 
the production repository.

Process of Upgrading the Analytics Web 
Catalog
You will need to upgrade your current Web Catalog to the new Oracle BI Presentation Catalog if your 
organization:

■ Has prebuilt applications already installed, and
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■ Has customized the current Web Catalog

NOTE: If you made no changes to the previous Siebel Analytics Web Catalog distributed with 
previous versions of prebuilt applications, you do not need to upgrade the catalog. You can begin 
using the newer version of the catalog.

CAUTION: Before you upgrade the Siebel Analytics Web Catalog, you must convert it to the Oracle 
BI Presentation Catalog format. For instructions, see Oracle Business Intelligence Infrastructure 
Upgrade Guide.

This process includes the following tasks:

■ Trimming the Input Web Catalog on page 58

■ Upgrading the Analytics Web Catalog to the Oracle BI Presentation Catalog on page 58

■ Testing the Results of the Presentation Catalog Upgrade on page 59

Trimming the Input Web Catalog
Before you upgrade and merge your current Web Catalog with the new Oracle BI Presentation 
Catalog, determine which of the existing content you want to keep and which new content you want 
to incorporate. Review your existing Web Catalog and determine the usage patterns of reports and 
dashboards. Note that some of the preconfigured content in the existing catalog may appear in the 
new version in a redesigned format. In addition, the new version includes completely new content. 
After you have decided the content that is to make up your enterprise Presentation Catalog, trim the 
input catalogs using the Catalog Manager. For information on trimming catalogs, see Oracle Business 
Intelligence Presentation Services Administration Guide.

Upgrading the Analytics Web Catalog to the Oracle BI 
Presentation Catalog
Upgrading the Siebel Analytics Web Catalog to the Oracle BI Presentation Catalog makes use of three 
catalogs:

■ The Original Siebel Analytics Web Catalog. This is the Web Catalog that you received with the 
currently-installed Siebel applications.

■ The Current Presentation Catalog. This is the Presentation Catalog that is installed in the 
OracleBIData\web\catalog folder with the installation of Oracle BI Infrastructure.

■ The Modified Web Catalog. This is the Web Catalog that you are currently using. 

You use Catalog Manager for this upgrade process. Catalog Manager compares the content in both 
the Current Presentation Catalog and the Modified Web Catalog with the content in the Original Siebel 
Analytics Web Catalog, merges any changes into the Current Presentation Catalog, and produces a 
list of upgrade differences, which you must resolve by indicating how you want the differences 
handled. If the catalogs have conflicting content, you can choose which catalog the content should 
be taken from. The end result is a merged Presentation Catalog that contains the site-specific 
changes, as well as new metadata. 
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To update the Presentation Catalog to a newer version

1 Make a backup copy of the Modified Web Catalog, rename the folder <catalogname>_old, and 
move it to a temporary location.

2 Copy the Original Siebel Analytics Web Catalog into the folder that holds your Modified 
Presentation Catalog and rename it <catalogname>_Original.

3 Start Catalog Manager and open the Current Presentation Catalog in offline mode.

4 Choose Tools > Upgrade Catalog.

5 In the Original Presentation Catalog field, browse to locate the Original Siebel Analytics Web 
Catalog.

6 In the Modified Presentation Catalog field, browse to locate your Modified Web Catalog, 
<catalogname>_old.

7 Click OK.

8 Resolve any upgrade differences as follows:

a Review each unresolved difference in the Unresolved differences list.

b For each unresolved difference, select the version that you want to keep.

c Click OK.

NOTE: The log file SiebelAnalyticsMigrationLog.txt holds information about the merge process. 
This log file is written to the location that holds the Presentation Catalog. If you get an error 
logged in the file, this means that the path in question had a problem that did not allow the merge 
mechanism to resolve the merge. No action was taken. To merge that particular item, go into 
your original Presentation Catalog and merge it manually.

9 Review the upgraded Web Catalog, and, if necessary, set permissions for objects.

10 Save the Current Presentation Catalog.

Testing the Results of the Presentation Catalog Upgrade
NOTE: Before you perform this step, you must first migrate the data into the upgraded data 
warehouse.

NOTE: The Web Catalog upgrade functionality does not automatically carry over object permissions; 
therefore, you should review the Web Catalog object permissions before you perform this step.

This step ensures that the upgraded reports and the new preconfigured reports are functional and 
render correct results within the new, merged Presentation Catalog. This step is typically performed 
by visually inspecting the final results of the complete end-to-end upgrade process. 

For upgraded reports, the preferred approach for comparison purposes is to have side-by-side 
environments, and have users review specific dashboard content between the two environments. 
Examine not only the look and feel of the application but also the data contained in the reports to 
make sure the content remains the same. It is recommended that you request users to use various 
elements of the user interface to validate results, such as global prompts, column selectors, report 
filters, drills, and navigations, as they normally do on a day-to-day basis.
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Also review the overall visibility and administrative settings in the new Presentation Catalog to 
ensure they are correct. Pay careful attention to the visibility rules that are established for any 
content that was migrated during the upgrade. You might have to manually adjust these settings.
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